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1 Introduction

The nexoDAQ-7620 is a wireless dynamic universal analog measurement device designed for
many different applications, ranging from high-speed measurements to low-power monitor-
ing. It is modular, versatile and highly configurable.

The nexoDAQ-7620 is equipped with three 24-bit data acquisition channels that can be soft-
ware configured to interface various types of sensors: £10 V differential signals, 10 V single-
ended signals, £100 V signals, full bridge, current loop (4-20 mA) signals, IEPE/ICP© sensors,
differential charge signals and single-ended charge signals.

The nexoDAQ-7620 achieves real-time wireless data acquisition at data rates reaching 10 kHz
per channel. The wireless protocol stack operates in the 2.4 GHz frequency band. Multiple
measurement devices form a network and report measurement data synchronized within less
than 100 ns. The data can also be communicated over USB or Ethernet, or be stored locally on
the on-board flash storage and retrieved later over wire or wirelessly.

In the highest power consumption mode, nexoDAQ-7620 achieves a running time of 2 hours
of continuous sampling and communication. Alternatively, it can be powered from external
sources, such as 24V standard industrial or 5V USB charger.

The nexoDAQ-7620 is rugged IP67 and has industrial operating range.

Information about warranty and liability can be found at: https://inertia-technology.com/terms-
and-conditions/.

. ne ODAQ

Inertia Technology

Figure 1: The nexoDAQ measurement device
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2 Setup

This section describes the high-level system setup.

2.1 System Description

The system consists of a number of nexoDAQ-7620 devices, the Advanced Inertia Gateway,
and the PC software (Inertia Studio) for configuring, monitoring and logging the sensor data. A
nexoDAQ-7620 device is referred throughout this document also as ‘'nexoDAQ device’, ‘device’,
‘sensor node’ or ‘node’. The Advanced Inertia Gateway is referred throughout this document
also as ‘gateway’.

The setup is depicted in Figure 2. The nexoDAQ devices communicate wirelessly with the Ad-
vanced Inertia Gateway, using the Inertia high-speed wireless protocol. The gateway is con-
nected through the mini-USB connector or the Ethernet connector with a computer that runs
the Inertia Studio software. The Advanced Inertia Gateway can synchronize to external systems
using trigger and clock signals, see Section 3.9.

Computer with
Inertia Studio software

USB or Ethernet

Advanced

Inertia Gateway Clock signal External system

© B e

A

(5) ‘IO“'
© Wref

Trigger

HIGH-SPEED WIRELESS NETWORK

nexoDAQ devices

Figure 2: Typical system setup
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2.2 Gateway Front and Back Panes

Figure 3 shows the front and back of the Advanced Inertia Gateway. On the front, the gateway
has two BNC connectors and four blue LEDs with the following functionality:

¢ RX: The gateway is receiving data.

e TX: The gateway is transmitting data.

e Power: The gateway is powered on.

¢ Sync: The gateway is synchronized with an external signal.

The EXT SYNC 1 and EXT SYNC 2 connectors can be configured as Input or Output, with either
Trigger or Sync functionality. See Section 3.9 for more information.

The backside contains a DC power connector, antenna, mini-USB connector and an 100BASE-
TX Ethernet connector. The gateway can be connected using the mini-USB or the Ethernet
connector to the PC.

When using the Ethernet connector, the gateway can be connected directly to the network
adapter of the PC using an Ethernet cable, or to a (wireless) switch/router in the same local
network as the PC. Inertia Studio requires Npcap or WinPcap on Windows and libpcap on Linux
and macOS to access the network adapter and receive the Raw Ethernet data. The gateway
has a local MAC address based on its serial number, e.g. 02:34:56:78:xx:xx, where xx:xx is the
serial number. The gateway sends its data to broadcast address ff:ff.ff.ff.ff:ff using EtherType
protocol Oxbabe.

L]

DC 712V ANTENNA o~ (ich, T
2Amax  24GHz500 T = 100BASE-TX

Figure 3: The front and back of the Advanced Inertia Gateway
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2.3 nexoDAQ Front and Back Panes

2.3.1 The Front Pane

The front pane (Figure 4) provides connections for three analog inputs, used for the connection
of external sensors. Each analog input has two associated LEDs, the Channel LED High and the
Channel LED Low. Additionally, there are two other LEDs, the Power and the Status LEDs. Each
LED can light up in two colors, red and green. The color code for each LED is described below.

O

Channel LED High

2 | 2 =1 2 [ 1
ONO) ONO ONO)
N (ONONO rARIONONO < JEIONONO
@ @ @ @ @ @
o} % o}

Channel LED Low

Status

o

O

Figure 4: The frontside connections of the nexoDAQ device

e Power
— Green: Powered, not charging.
— Solid red: Powered, charging.

— Blink red (1s every 5s): Off, charging.

Status:
— Red: Communication (USB/Wireless).

— Green: Unassigned.

Channel LED High:
— Red: Channel configured, not sampling.

— Green: Channel configured and sampling.

Channel LED Low:

— Unassigned.

O
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Figure 5 shows the frontside panel of the nexoDAQ device, powered and not charging (the
Power LED is green), where the analog inputs are connected and sampling (all Channel LED
High LEDs are green) and there is wireless communication with the gateway (the Status LED is
red).

Figure 5: nexoDAQ front panel with sensors connected and wireless communication

inertia-technology.com Page 8 of 83
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2.3.2 The Back Pane

On the back pane there is a barrel connector for power supply, a micro-USB connector for the
communication with a PC, an SMA connector for an antenna, enabling wireless communication
with the Inertia Gateway, and the power button, as shown in in Figure 6.

O @

DC
5-24V
15w

ANTENNA

@ usB [ )
O O

Figure 6: The backside connections of the nexoDAQ device

Figure 7 shows the backside panel of the nexoDAQ device with the power button hightlighted.
The connectors for power, micro-USB and antenna are also visible.
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Figure 7: nexoDAQ back panel with power, micro-USB and antenna connectors, and the
power button

inertia-technology.com Page 10 of 83
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2.4 Powering

The nexoDAQ can be powered from an external power supply, from the micro-USB connector
and from the internal battery.

The 2.5 mm ID/5.5 mm OD barrel connector is used when connecting to the external power
input, as shown by the schematics in Figure 8. The voltage for the external power input ranges
from 5to 24 V. However, it is recommended to use a voltage above 7V, especially when charging
a depleted battery.

Vi O

Figure 8: The barrel connector for external power supply

The micro-USB connector is used to make a connection with the computer for data transfer
or to a USB power adapter for recharging the batteries. Please note that the current supplied
from the computer using the micro-USB connector is not sufficient for operating the device
in full-power mode. Therefore, it is necessary to use an external power input or the internal
battery will be drained.

The internal battery of the nexoDAQ device should be periodically recharged. It is recom-
mended to use the external power supply or the micro-USB connected to a wall adapter. Dur-
ing recharging keep the device turned off. Monitoring the battery voltage can be done using
Inertia Studio (see paragraph 3.1.3.2). When the battery is empty the device will automatically
turn itself off.

The gateway has no internal battery and therefore does not require recharging.

2.5 Calibration

The nexoDAQ is calibrated over a range of temperatures and for at least two levels of supply
voltage.

The nexoDAQ calibration applies a set of correction factors to various aspects of the signal path
for different frontends over a temperature range from -10°C to 30°C. This calibration is neces-
sary because both the silicon leakage and the FET resistances strongly depend on temperature.
Therefore, the offset, the gain and the optional 200 Ohm input shunt resistor are temperature-
dependent. The calibration is carried out in a temperature chamber and the calibrations are
performed at fixed temperature steps.

Additionally, the signal path supply voltage has also an effect on the offset and gain. Calibra-
tion is therefore performed for at least two levels of supply voltage. The calibration values
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form a two-dimensional space (temperature and supply voltage) within which the nexoDAQ
interpolates to get to any point in that space.

2.6 Connecting the Sensors

The nexoDAQ provides connections for three analog inputs on the front, used for connecting
external sensors (see Section 2.3.1). This section describes how the various sensors are con-
nected to the nexoDAQ analog inputs. For information on how to configure these sensors in
the Inertia Studio software, see Section 3.8.

nexoDAQ analog inputs can be connected using the cables provided along with the device.
These cables with 7 wires have on one end the Lemo circular connector with 7 contacts and
on the other end a pigtail connector.

The Lemo circular connector can be inserted into one of the nexoDAQ analog inputs. When
inserting the connector into the analog input, attention has to be paid such that the red dot
on the connector points upwards (Figure 9).

Figure 9: Connecting the Lemo connectors to nexoDAQ analog inputs

The pigtail is used for connecting the various sensors to nexoDAQ. Table 1 describes the cor-
responding pin assignments of the nexoDAQ device.

In the following, we present the wire connections needed for the different sensors that can
interface with nexoDAQ.

inertia-technology.com Page 12 of 83
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Table 1: Pin assignments of the nexoDAQ device

—

1 EX- Negative excitation output

© G 2 T2 TEDS Class 2
3 AIN—- Negative analog input

e @ e 4 AIN+ Positive analog input

@ @ 5 GPIO General Purpose Input/Output
6 EX+ Positive excitation output
7 GND Signal ground

2.6.1 +10 YV Differential Signals

You can connect £10 V differential signals to the nexoDAQ, as shown by the schematics in Figure
10. The nexoDAQ optionally provides positive and negative sensor excitation up to 30 V.

& Ouse )

b o |
EX+ ¢ EX+ i
EX- (l:) EX- i

Figure 10: Connecting 10 V differential signals

inertia-technology.com Page 13 of 83
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2.6.2 10V Single Ended Signals

You can connect 10 V singled ended signals to the nexoDAQ, as shown by the schematics in
Figure 11. When using this setup the AIN—input on the nexoDAQ must be connected to GND.
The nexoDAQ optionally provides positive and negative sensor excitation up to 30 V.

’]\ O am+

I
I

X '
GND | GND :
AIN- :

I

I

I

I

I

EX+ O EX+
EX- Q ex-

Figure 11: Connecting 10 V single ended signals

inertia-technology.com Page 14 of 83
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2.6.3 Full Bridge

You can connect a full bridge to the nexoDAQ, as shown by the schematics in Figure 12. The
nexoDAQ optionally provides bridge excitation from 5 V up to 30 V with a maximum load cur-
rent of 25 mA.

O
OI AIN+
O
o

nexoDAQ-7620,

Figure 12: Connecting a full bridge

Note: When a lower excitation voltage is required use GND instead of EX—. This reduces the
excitation voltage range to 2.5 V up to 15 V.

inertia-technology.com Page 15 of 83
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2.6.4 +100YV Signals

You can connect £100 V signals to the nexoDAQ, as shown by the schematics in Figure 13. The
nexoDAQ optionally provides positive and negative sensor excitation up to 30 V.

Figure 13: Connecting 100 V signals

inertia-technology.com Page 16 of 83
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2.6.5 IEPE /ICP© sensors

IEPE/ICP© sensors are active sensors that require a constant current supply. The sensor in turn
modulates the voltage with the sensed signal around a bias voltage.

You can connect IEPE sensors to the nexoDAQ, as shown by the schematics in Figure 14. The
nexoDAQ has a built-in excitation current source for each channel.

@ 0.1-10 mA IEPE
AIN+

)

0]
=
o

>
RREEEIe T o EEEE

Figure 14: Connecting IEPE / ICP© sensors
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2.6.6 Differential Charge Signals

You can connect differential charge signals to the nexoDAQ, as shown by the schematics in
Figure 15.

A S 3
:l: g AIN-

1
1
1
1
1
1
GND O cnp :

Figure 15: Connecting differential charge signals
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2.6.7 Single Ended Charge Signals

You can connect single ended charge signals to the nexoDAQ, as shown by the schematics in
Figure 16. When using this setup the AIN— input on the nexoDAQ must be connected to GND.

f]\ O ams+

GND W/ : GND
AIN-

Figure 16: Connecting single ended charge signals
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2.6.8 Current Loop (4-20 mA) Signals

You can connect current loop signals to the nexoDAQ, as shown by the schematics in Figure
17. The nexoDAQ optionally provides current loop sensor excitation up to 15 V.

,]\ RF & Mia s Ay R g 0
O EX+
g o AIN+

Figure 17: Connecting a current loop signals

inertia-technology.com Page 20 of 83
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2.7 Installing the Application

This section explains the installation of the Inertia Studio application on various operating sys-
tems. For information on performing an measurement with nexoDAQ, please see Section 4.

The Ineria Studio application runs under Windows, Linux and macOS operating systems. In the
following, we describe the installation procedure in each of these environments.

2.7.1 Windows

On a Microsoft Windows computer, unzip and run the Inertia Studio setup executable. During
the setup process, the Inertia driver and the Visual C++ redistributable are installed (Figure 18).
This may require a computer reboot. Choose a destination folder and press the Install button
(Figure 18).

A Inertia Studio 3.7.2 Setup = x X Inertia Studio 3.7.2 Setup = x
Choose Components Choose Install Location <
Choose which features of Inertia Studio 3.7.2 you want to install. ,ﬁ Choose the folder in which to install Inertia Studio 3.7.2. (‘&
Chedk the components you want to install and unchedk the components you don't want to Setup will install Inertia Studio 3.7.2in the following folder. To install in a different folder, dick
install. Click Next to continue. Browse and select another folder. Click Install to start the installation.

Select components to install: Inertia Studio

Inertia USB-Serial Driver
Wisual C++ Redistributable

Create Desktop Shortout Destination Folder

+| Create Start Menu Shortcut

C: \Program Files\Inertia Studio Browse...
Space required: 98.5 MB Space required: 98.5 MB

Space available: 53.8 GB

< Back Next > Cancel < Back Install Cancel

Figure 18: Inertia Studio installation in Windows

2.7.2 Linux

In Linux Ubuntu, install the package with the following command:
sudo dpkg -i inertiastudio-[version].deb
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2.7.3 mac0S
On a macOS device, open the *.dmg file as follows:
¢ On an Apple silicon device, open the armé64 version of the *.dmg file.
¢ On an Intel device, open the version without armé64 in the *.dmg file name.

Afterwards, drag the Inertia Studio application to the Applications, as shown in Figure 19.

@ @ [C} inertiastudio-3.7.2-mac0S-arm64
e s
), 4
& ;
’
Applications InertiaStudio.app

) inertiastudio-3.7.2-macOS-arm& 4

Figure 19: Inertia Studio installation in macOS
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Inertia Studio can be used for realtime visualization of sensor data, logging of sensor measure-
ments and pre-computed orientation, and configuration of sensor and wireless parameters.
This section describes Inertia Studio (v3.7.1) in more detail.

Inertia Studio is available for Microsoft Windows, Ubuntu Linux and macOS.

Figure 20 shows the main screen of Inertia Studio, which is divided in the following areas:
¢ The menu and toolbar at the top (described in Section 3.1.1)
e The sensor data plots in the middle (described in Section 3.1.2)
¢ The information area at the bottom (described in Section 3.1.3)

In the following, these three areas are presented in detail.

Figure 20: Inertia Studio with one nexoDAQ node, showing data and FFTs from three sensors
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3.1.1 Toolbar and Menu

The toolbar is used to quickly access the most used functionality of Inertia Studio. This section
describes the default buttons of the toolbar, from left to right (see Figure 21).

Eile Configuration View Help

Connect Record Pause Sensor Settings  Preferences Hide Clear Layout Tracker ZoomIn  Zoom Out

o

Figure 21: Inertia Studio menu and toolbar

¢ Connect / Disconnect
The Connect / Disconnect button can be used to quickly connect to, or disconnect from an
Inertia device. The drop-down menu associated with this button opens a list for selecting
the target device. See Section 3.2 for more information.

e Record / Stop
When connected to a device, the Record / Stop button can be used to quickly start and
stop logging/recording to file (see Section 3.3). If timed recording is enabled, a small clock
overlay is shown on the icon. The drop-down menu associated with this button offers rapid
access to the Logging Configuration window (see Section 3.3). The user can also quickly set
the duration of the recording using time-presets.

e Pause / Resume
The Pause / Resume button is enabled when replaying a logfile. It can be used to pause and
resume the replay.

e Sensor Settings
The Sensor Settings button opens the Sensor Settings window (see Section 3.8).

¢ Preferences
The Preferences button opens the Preferences window (see paragraph 3.12.2.2).

¢ Hide / Show
The Hide / Show button toggles between hiding and showing the data in the plots. The
drop-down menu associated with this button opens a list for selecting the target device for
which the data is hidden or shown. An small sign (i.e. red cross or yellow triangle) on the
icon indicates that some data is hidden. This button does not influence the logging.

e Clear (F5)
The Clear button, or F5, clears the plots, legend and device lists. This button does not influ-
ence the logging.

¢ Layout
The Layout button opens the Layout Wizard (see Section 3.12.1) and has a drop-down menu
to switch between layouts.
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Tracker
The Tracker button opens the Tracker window (see Section 3.10).

Zoom In (F3) / Zoom out (F4)
The Zoom buttons, or F3 and F4, can be used to zoom the X-Axis of all plots in or out.

The menu allows access to all the options of Inertia Studio and has the following items:

File

—Connect opens the Connection Configuration window (Section 3.2).

—Record opens the Log to File (Section 3.3) and Log to Flash (Section 3.4.1) windows.
—Replay opens the Replay window (Section 3.7).

—Download opens the Download Logfiles window (Section 3.4.2).

—Fill-in Lost Samples opens the Fill Loss window (Section 3.5).

—Export opens the Export Logfiles window (Section 3.6).

—EXxit closes Inertia Studio.

Configuration

—Sensor Settings opens the Sensor Settings window (Section 3.8).

—1/0 Settings opens the I/0 Settings window (Section 3.9).

—Sensor Calibration opens the Calibration Configuration window. This setting is not appli-
cable to nexoDAQ.

—Preferences opens the Preferences window (paragraph 3.12.2.1).

—File Types opens a sub-menu to configure the supported file types.

—Power Down allows the user to remotely power down specific devices.

View

—Layout Wizard opens the Layout Wizard (Section 3.12.1).

—Tracker opens the Tracker window (Section 3.10).

—Detailed Status opens the Detailed Status window (paragraph 3.1.3.4).

—Toolbox can be used to show or hide the Zoom and Pan sliders and the Log and Legend in
the information area.

—Toolbar can be used to change the appearance of the toolbar. The toolbar can be hidden
using the Hide option. The size of the toolbar icons can be modified to Small, Medium and
Large. Show Text allows to show or hide the text below the icons. Show I/0 Buttons adds
two extra buttons to the toolbar for I/O functionality.

—Show Data toggles between showing and hiding the incoming data in the plots.

—Clear Plots (F5) clears the plots, legend and device lists.

—Full Screen (F11) shows Inertia Studio in full-screen mode.

Help

—Check for Updates checks if a new version of Inertia Studio is available, or if new firmware
for the connected nodes is available.

—Firmware Update opens the Firmware Update window (Section 3.13).
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—Software Web Site opens the Inertia Technology software website.
—Manual (F1) opens the Inertia Studio manual.
—About shows the current Inertia Studio version and build date.

3.1.2 Plots

Inertia Studio can be configured to display a customizable number of plots that show in real-
time the sensor data, status data (e.g. battery voltage, lost samples) and processed data (e.g.
FFT). The shown plots and layout can be customized via the Layout Wizard (see Section 3.12.1).
The X-axis of the time-plots represents the number of seconds since the gateway was started.

The mouse can be used to zoom and pan the plot. Holding the left mouse button while moving
the mouse creates a zoom-box. Releasing the left mouse button zooms to the selected data.
Note that Auto-scaling resets the Y-axis zoom. A plot can be panned by holding the right mouse
button and moving the mouse. By default, the X-axis is automatically set to the latest received
data. Disable Show Data or use the pan slider (see Section 3.1.3) to prevent this.

Right-clicking on a plot provides the following options (see Figure 22):

Fit
Zoom In
Zoom Qut
Lock X-axis...
Lock Y-axis...
~  Auto-Scale Y-axis

Save as SVG...
Figure 22: Plot right-click pop-up menu

¢ Fit: Fits all received data in the plot.

e Zoom infout: Zooms the plot in or out. The Zoom buttons in the toolbar and the Auto-
scaling option (see paragraph 3.12.2.2) can be used to reset the zoom.

* Lock X-axis...: Locks the X-axis to a specified range by showing a pop-up window in which
the minimum and/or maximum values of the X-axis can be set. When the axis is locked,
a < and/or — symbol is shown at the bottom right and/or left corner of the plot. This
option is only enabled for FFT plots.

e Lock Y-axis...: Locks the Y-axis to a specified range by showing a pop-up window in which
the minimum and/or maximum values of the Y-axis can be set. When the axis is locked,
a 1 and/or | symbol is shown at the left top and/or bottom corner of the plot. Locked
plots do not auto-scale.

e Auto-Scale Y-axis: Toggle automatically scaling the Y-axis. This overrules the global auto-
scaling option in paragraph 3.12.2.2.

e Save as SVG...: Save the plot as a SVG image.
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3.1.3 Information Area

The information area at the bottom of the main screen shows the list of event messages and
the legend with connected device. In addition, a zoom-slider, a pan-slider and buttons to set
and get the time of the devices can be added to the information area via the menu (View,
Toolbox).

3.1.3.1 Notification Area

Event notifications are displayed in the notification area. They give information about the out-
come of certain actions, such as plugged-in or removed devices, connecting to or disconnecting
from a device, starting or stopping logging, downloading or exporting files, modifying sensor
configurations, etc. By clicking the header of the time column, the notifications can be sorted
in ascending or descending time order. Right clicking an item in the list provides the following
options: copy the selected line(s), copy all lines, and clear the notification area.

The icon in front of a message indicates the notification type. A green check-mark means
success, a red cross means error, an orange triangle means warning and a blue circle means
information.

3.1.3.2 Legend

The legend contains a list of all the devices of which sample data is received. The first column
shows the line colour and ID for each device. The NodelD can be extended with a name in para-
graph 3.12.2.3. The second column (Signal) displays the radio signal strength (when connected
via a gateway), or the transmission type (when connected via USB). The third column (Battery)
shows the battery level for each device, and whether the device is charging. The fourth column
(Loss) shows the percentage of lost samples over the last period (see also paragraph 3.12.2.1).
The fifth column (Flash) shows whether the device is logging to flash or not. The legend can be
sorted on every column. Columns can be hidden by right-clicking the column header. Double-
clicking on the legend opens the Detailed Status window (see paragraph 3.1.3.4).

The radio strength is updated every second. The battery level is, by default, updated every
ten seconds. The loss update interval can be configured via the global preferences (see para-
graph 3.12.2.1).

3.1.3.3 Zoom and Pan

The zoom and pan sliders can be used to change the visible data in the plots. The zoom slider
behaves the same as the zoom buttons in the toolbar (Section 3.1.1) and allows to zoom the
X-axis in or out. The pan slider allows the move back in time and show older data. The maxi-
mum number of seconds to pan can be configured in the global settings (Plot History in para-
graph 3.12.2.1). If panning is active, plots are not updated with new sample data.

3.1.3.4 Detailed Status
The Detailed Status Overview window (see Figure 23) can be accessed by double clicking an
item in the legend or via the View menu, sub-menu Detailed Status. The window shows de-
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tailed information about the battery level, CPU temperature, external input, RSSI and sample
loss of the connected devices. The plots are cleared when (re)connecting to a device or when
using the Clear button.

Detailed Status Overview

[ Auto-Update Plots | Send Request

g
s
5
8
5
2
5

RSSI (dBm)

Figure 23: Detailed Status information

The battery, temperature and external input plots are updated when status information from
a device is received via automatic status messages (usually every ten seconds). The RSSI plot
is updated every second with the average value of the received RSSI information. The sample
loss plot is updated every second with the detected sample loss. The time on the X-axis is the
system time.

A checkbox is available to disable automatic updating of the plots. This can be used to prevent
the plots from resetting when zoomed in. The Send Request button broadcasts a message to
all devices with a request to send the current battery and CPU temperature value. The Plots
button can be used to show or hide specific plots.
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3.2 Connecting to a Device

In this section we describe how an Inertia device can be connected to the PC, using the follow-
ing connections:

e USB: Any Inertia device can be connected to the PC using USB. The mini-USB connector of
the gateway and the micro-USB connector of nexoDAQ can be used for direct connection
to the PC using a USB cable.

e Ethernet: The Advanced Inertia Gateway can also be connected using Ethernet to the
PC. The gateway can be connected either directly to the network adapter of the PC using
an Ethernet cable, or indirectly using an Ethernet cable to a (wireless) switch or router
that is in the same local network as the PC. Inertia Studio requires Npcap or WinPcap on
Windows and libpcap on Linux and macOS to access the network adapter and receive
the Raw Ethernet data.

The connection can be started via the Connect button in the toolbar or from the File menu
item, option Connect.

3.2.1 Connecting to a Device Using the Toolbar

Pressing the arrow next to the Connect button in the toolbar opens the drop-down menu
shown in Figure 24:

¢ The option Connect... opens the Connection Configuration window, which is explained
in Section 3.2.2.

e The option Available... opens a pop-up window with all the available devices, including
the active network adapters. A setting in the Global Preferences (Section 3.8.1) can hide
the network adapters from the list of available devices.

¢ Below the line, a list is shown with the names of the available Inertia devices connected
through USB and the active network adapters, i.e. the local and/or the wireless network
adapters. Next to them, the corresponding port numbers are given. A e symbol in front
of the name indicates the device is selected. A » symbol in front of the name indicates
the device is connected.

Select the desired device and press the Connect button in the toolbar to connect.

3.2.2 Connecting to a Device Using the Menu

The option Connect from the File menu item opens the Connection Configuration window from
Figure 25. The window shows a list with Stored Configurations, i.e. all the connections to Iner-
tia devices that were previously used and those that are currently available. The list includes
the devices connected through USB and the active network connections, e.g. the local and/or
the wireless network connections. The port name (“com*“ on Windows and “/dev/*“ on Linux)
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File Configuration WView Help

Connect...
Available...

L KL

. Inertia Gateway Adwvanced 142 [com23]
nexoDAQ 8 [com24]

Figure 24: Connect drop-down menu

is shown next to the device name. A green dot indicates the device is available. The » symbol
indicates the device is connected.

By pressing the Available? button, the list is updated and a pop-up window with all the avail-
able devices is shown. The Show button loads the selected connection into the main screen.
The Add... button can be used to manually add a device to the list if it is not automatically de-
tected. The Remove button removes a selected device from the list. The Connect/Disconnect
button starts and shows, or stops, the selected connection with the device.

Connection Configuration x

Stored Configurations

Available Connected Port Name =
9 com24 nexoDAQ &
. comZ3 Inertia Gateway Advanced 142
I com10 PraMove V Node 39 I
com11 ProMove V Node 35
com12 ProMowve ¥V Node &
com13 ProMove V Node 40
com14 PraMove V Node 9
com16 ProMowve ¥V Node 42
| com17 Equi-Pro Gateway 12
! com18 PraMove V Node 43
! com19 Inertia Gateway Advanced 7
| com3 Inertia Gateway Basic 123 ¥
Available? Sha Add.. Remove

| ~ Advanced

Connect

Figure 25: Connection Configuration
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3.3 Logging to File

When connected to an Inertia device, the incoming data can be stored/recorded in a log file.
The default file format is itlog (Inertia Log File). Incoming samples, node information and con-
figurations, etc, are stored in the file. An itlog file can be exported to a different format (see
Section 3.6).

There are two options that can be used to enable logging to file:

1. By using the Record button from the toolbar; to change the settings for creating a log
file, select the Log to File... option from the drop-down menu of the Record button; this
option opens the Logging Configuration window for logging to file (see Figure 26).

2. By selecting the Log to File... option from the File menu, Record item; this option opens
the same Logging Configuration window for logging to file (see Figure 26).

Logging Cenfiguration X

Log to File Logto Flash
Log to File Settings

Filename
Chexperiments\logfile.itleg Browse
Description
Compression MNone ~
Unique Filename Date in Filename

Stop Logging After  [] | 0 Z|lmw (o =

-

Start Flash Logging

MNew File Every

Actions After Stopping (.itlog)

Fill-in Lost S5amples
Export A

Record

Close

Figure 26: Log to File Configuration

In the Logging Configuration window, the settings for creating a log file can be modified as
follows:

e Filename: The name of the log file. The default file format is itlog.

e Description: A description that can be added to the beginning of the (exported) log file.
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e Compression: An optional compression format used for the log file, resulting in a smaller
file size. Supported compression methods are: gzip (.gz, GNU Zipped Archive), bzip (.bz2,
BZIP2 Compressed Archive) and zlib (.Z, UNIX Compressed Archive).

¢ Unique Filename: Selects the way of handling existing log files with the same name:
— Overwrite: The existing file is overwritten.

— Auto-Number: Files are numbered in sequence with the following naming convention:
<filename>[_Ne].ext, where ext is the file extension and Ne is the sequence number;
this number is automatically increased every time a log file with the same name is
created.

— Date in Filename: The current local or UTC date and time are added to the filename;
the timestamp is formatted as described in 1ISO 8601
(i.e. [YYYYMMDDThhmmss_]<filename>.ext).

e Stop Logging After: This option can be enabled to automatically stop logging to file. The
duration can be entered as hh:mm:ss. When active, a countdown is shown in the toolbar.

o Start Flash Logging: Starts (and stops) logging to flash when a log file is created. This option
is enabled by default when Fill-in Lost Samples is enabled.

* New File Every: Start logging to a new file once the provided number of seconds or file size
is reached. Fill-in Lost Samples and Export should be disabled.

e Fill-in Lost Samples: Fills-in lost samples when logging to file is finished (see Section 3.5).

e Export: Exports the log file when logging to file (including filling in lost samples) is finished.
The button opens the Section 3.6 window.

If a device is connected, the Record button can be used to save the settings and start creating a
log file. If the device is disconnected, the Save button can be used to save the current settings.
The Stop button can be used to stop logging. These buttons behave similarly to the Record /
Stop button in the toolbar, described in Section 3.1.1.
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3.4 Logging to Flash

nexoDAQ nodes have an internal flash memory that can be used to store sensor data. Flash
logs can be created manually, as described in Section 3.4.1. Section 3.4.2 describes the way
the flash logs can be downloaded to the PC.

3.4.1 Starting and Stopping a Flash Log

The Log to Flash option from the File menu, Record item, opens the Logging Configuration
window for logging to flash (see Figure 27).

The Logging Configuration window shows the list of all devices in the network. For each node
in the list, the » symbol indicates whether the node is logging to flash or not. If a timer is used
when starting the flash log (the Stop Logging After option is enabled), a countdown is visible
in the list. The last column in the list shows the sensor data types that are logged to flash (see
Section 3.8 to enable or disable sensors).

Logging Cenfiguration *
Log to File = Log to Flash
Log to Flash Settings
a» Nodel[j\ Timer Logging Data From:
] 142 (Gateway) I/O Events.
EB 8 nexoDAQ Channel(s).
Stop Logging After [] 0O = 2o =
Start Stop

Figure 27: Log to Flash Configuration

The Start / Stop buttons can be used to send a command to the checked node(s) to start or stop
logging to flash. The Stop Logging After option activates a timer for stopping the flash logging.
Closing Inertia Studio while a timer is active does not determine a node to stop logging to flash.
The format of the timer is hh:mm:ss.
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When starting or stopping a flash log, a notification message appears in the information area at
the bottom of the main screen with the response from the node, indicating success or failure.
A failure can occur when logging to flash is already started (or stopped).

Flash logs are named LOG<Ne>.LOG, where Ne is the first available number starting from 1.
The creation date of the flash log is also recorded. The date is based on the internal clock
of the node. If the battery of a node is fully drained, the clock is reset, which can result in
an incorrect creation date. The internal clock is automatically synchronized with the PC time
when data from a node is received by Inertia Studio.

3.4.2 Downloading a Flash Log

Downloading a flash log can be done either wirelessly or through a USB cable, which is much
faster. By selecting the Download option from the File menu, the Download Flash Logs window
appears, as shown in Figure 28. When a node is selected in the drop-down list, status informa-
tion about the internal flash is shown, and the File list is updated with the flash logs present
on the internal flash of the node. The filename, file-size and creation date (local time) of each
file is shown in the list. By selecting a node or using the Refresh button on the right hand side,
the status information and file-list are updated. Active files (e.g. files currently being created)
are not included in the file list.

To download a file, select it in the File list and adjust the following options:

e Destination: The name of the file (itlog format). Several wildcards are supported in the
filename:

— {name} or %s: Insert the full flash file name (without extension).

— {no} or %d: Insert the number of the flash file (e.g. 34 for LOG34.LOG).

— {date} or %c: Insert the creation date of the flash file (in ISO 8601 format).
— {id} or %i: Insert the node ID.

¢ Unique Filename: Selects the way of handling existing log files with the same name (same
as in Section 3.3).

¢ Use Date from Flash File: Set the creation date of the file to the date of the flash file.

e Export: Export the file when downloading is finished. Use the button to open the Export
Settings. (see Section 3.6).

Press Download to start the download. If the node is transmitting data, transmission will be
temporarily disabled until the download is finished.

During downloading, the progress is shown in the list. Information about the progress is also
shown in the information area at the bottom of the main screen (see paragraph 3.1.3.1). When
downloadingis in progress, the Cancel button can be used to cancel the process. If afileis being


http://www.inertia-technology.com

downloaded, other files of the node can be queued so they will start downloading as soon as
the current file is finished. Select one or more LOG*.LOG files, adjust the file options, an press
Queue.

. Download Logfiles x

MNode Overview

Node: 8 v -"l::'-:\_\\ Format..
Status: OK

6MB / 29496 MB (5 files)
Name Size Created Progress Status
COMFIG.CFG 340 B 2024-11-1513:37:.08
SYSTEM~1. OB 2024-01-22 10:39:18

LOG1.LOG  4579KB 2024-03-12 14:.09:24
LOG210G  91,7KB  2024-07-11 16:08:22
LOG3.1OG 55MB  2024-11-21 16:09:48

Destination
CAlnertia\(id}-{name} itlog | Browse |
Unigue Filename Date (local) in Filename -

Use Date from Flash File [

Export 8 £
Download Cance

Close

Figure 28: Download Flash Logs

3.4.3 Deleting Flash Logs

Flash logs can be removed from the flash memory using the Format button in the Download
Logfiles window (Figure 28). This action removes all files from the internal flash memory. For-
matting takes about 5 to 10 seconds. A message is shown when formatting is finished.

Do not turn the nodes off during formatting!


http://www.inertia-technology.com

3.5 Filling in Lost Samples

When performing an experiment with wireless sensor nodes, there is almost always some data
loss. This loss can be filled in automatically after the experiment is finished. This feature is
available only for experiments performed with a gateway, when the sensor nodes are in Syn-
chronous mode (see Section 3.8.1 for details about sampling mode). If the sensor nodes are in
Stand alone mode, or if the sensor nodes are connected using a USB cable this feature is not
available.

The sections below explain this process of filling in the lost samples.

3.5.1 Automatic

Enable Fill-in Lost Samples when creating a logfile (see Section 3.3). Once logging is stopped,
a pop-up is shown informing that missing data will be filled in. Once continued, the Fill-in Lost
Samples window is shown (Figure 29) and missing data is automatically filled in.

The process consists of three stages:

1. First, the existing logfile is analyzed and missing data of each node is identified. During
this stage, a progress bar for each node is filled with blue bars. The tint of the color rep-
resents the amount of lost data: white is 100% loss, dark blue is 0% loss. The percentage
inside the progress bar is the total percentage of samples available.

2. During the second stage, the missing data is requested wirelessly from the nodes (Fig-
ure 29). The progress bars are actively being updated to reflect the received data. The
lighter segments change to dark-blue.

3. Inthe third stage, the received data is merged into the itlog file (Figure 30). The progress
bars are filled with green bars to show the progress. If there is still some missing data,
sections in a progress bar are made red and messages with information about the miss-
ing sections are added to the notification area. A manual restart could fill in the remain-
ing missing samples (see Section 3.5.2).

Fill-in Lost Samples X Fill-in Lost Samples

: Manual Settings Manual Settings

Progress Progress

+ I
File: logfileitlog File: logfileitlog

Status: Requesting samples... Status: Merging...

| Details | Details

Cancel Close Cancel Close

Figure 29: Requesting Figure 30: Merging

Once the process is finished, and if Export was enabled when the logfile was created, the file
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is exported in the background. If the fill-loss process is canceled using the Cancel button, a
pop-up asking to continue with export is shown.

3.5.2 Manual

Filling in lost samples can also be started manually. Open the window via the menu (File, Fill-in
Lost Samples) and expand the manual settings using the Manual Settings arrow (Figure 31).
Provide the following parameters:

* File(s): One or more itlog files to be filled in.
e Port: The port used to access the node(s), usually the port of the gateway.

e Export: Export the itlog file when filling in lost samples is finished or canceled. Use the
button to open the Export Settings. (see Section 3.6).

e Backup: Keep a backup of the unfilled file (named <filename>_BACKUP_.itlog).

e Slots: Temporarily change the number of slots (to a lower value) to increase the fill-loss
speed. This should be equal or higher than the number of devices in the network. Leave
empty or use O for the default number of slots.

¢ Flash Diff (S): The maximum time difference in seconds between the creation date of the pc
file and the node’s flash file.

Press Start to start the process.

Fill-in Lost Samples X

Manual Settings

Fill S5ample-Loss Settings

File(s) ‘ logfile.itlog ‘ Browse

Port comd - Inertia Gateway 8~
Export O &

Backup

Flash Diff (<)

Start

Progress

File:
Status:

Details

Cancel Close

Figure 31: Manual settings

The Details arrow expands the window and shows a list with all status messages. The messages
can be copied or cleared using the Copy and Clear buttons. The Auto-scroll checkbox enables
or disables automatic scrolling to the latest message.
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3.6 Exporting a Logfile

Inertia Log Files of type itlog can be exported to different file types using the Export Logfiles
window (see Figure 32), which can be accessed from the menu (File, Export). The following
parameters can be modified:

e Format: The file format to export the itlog file to (Figure 33). Settings specific to the file
format can be modified via the Configure button (see the next sections for available options).

e Compression: An optional compression format used for the exported file, resulting in a
smaller file size. Supported compression methods are: gzip (.gz, GNU Zipped Archive), bzip
(.bz2, BZIP2 Compressed Archive) and zlib (.Z, UNIX Compressed Archive).

¢ Unique Filename: Selects the way of handling existing log files with the same name (same
as in Section 3.3).

e Source(s): The itlog file(s) to export or merge. The Destination filename is automatically
updated to match the source name and the selected file format.

Use the Start button to save the settings and export the file(s). Active and previously exported
files are shown in the Activity List. Double-clicking an item opens the exported file in its default
program. An active item can be canceled using the Cancel button. Previously exported files
in the activity list can be cleared using the Clear button. The folder of a selected item can be
opened using the Open Folder button.

Export Logfiles X Export Logfiles X
Settings Settings
Format csv ~ | Configure Format Configure

Compression None e

Unique Filename Auto-Number b

Source(s)
C\Users\Raluca\OneDrive\Inertia\Testing\2024-11-21 nexo t¢ = Browse

Destination
C\Users\Raluca\OneDrive\lnertia\Testing\2024-11-21 nexo te Start

Activity List
Source Destination
nexo_logfile_3axis_ICP_1.itlog nexo_logfile_3axis_ICP-[nodelD][_Na].csv

Cance Clear Open Folder

Close

Figure 32: Export logfiles

Supported export formats:
CSV: Comma-Separated Values File

MAT: Matlab File

V3D: Visual3D ascii File

ITLOG: Inertia Technology Lagfile (merge files together)

Compression

Unique Filename

Source(s)
24-11-21 nexo testing\nexo_logfile_3axis_ICP_l.itlog = Browse

Destination
024-11-21 nexo testing\nexo_logfile_3axis_ICP_1.csv Start

Activity List
Source Destination Pro
nexo_logfile_3axis_ICP_1.itlog nexo_logfile_3axis_ICP_1.txt 100

ance Clear Open Folder

Close

Figure 33: File format options
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3.6.1 (CSV Settings

Inertia Log Files can be exported to a Comma Separated Values file (CSV). The CSV Settings can
be modified in the CSV Settings window (see Figure 34), accessible via the menu (Configuration,
File Types, CSV Settings) or from the Export window.

A CSV file starts with a header identifying each column. Each subsequent line in the CSV file
consists of a timestamp and the sensor data sampled at that timestamp.

The following settings can be modified for the CSV file format:

* One File per Node: A separate file is created for each node; the node number is appended
to the filename: <filename>[_nodeNe].ext. When disabled, one file with data from all nodes
is created.

e Repeat Previous Value: When sensors have a lower sampling rate than the global sampling
rate, empty values are added to the CSV file (no value between commas). . By using this
option, instead of logging an empty value, the last received value is repeated until a new
value is received.

¢ Add Info to Beginning of File: Add information such as node information, sensor settings,
units of measurement, a description, etc, to the beginning of the log file. The information
lines start with a #.

The sensor data added to the CSV file can be configured by (un)checking the desired Columns.
For nexoDAQ, the data is made available in the logfile by selecting the ADC option. The Ap-
ply button saves the settings and closes the window. The Close button discards any modified
settings and closes the window.

CSV Settings X
Settings Columns
8 One File per Node Timestamp

() SegNr, Slat, Index

[CJ Repeat Previous Value
Node ID

Add Info to Beginning of File oS
O Accelerometer

[ Compass

[ Gyroscope

RSSI Include the gyroscoj
CJRTC

) Orientation (Quaternion)

[T Orientation (Euler Angles)

B ADC

0 Status

) Accelerometer (High G)

(U Pressure

[ Temperature

CimMa

Oio

Extra Files

[JGNSS

Apply Close

Figure 34: CSV Settings
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3.6.2 MAT Settings

Inertia Log Files can be exported to a MatLab MAT file. The MAT Settings can be modified in
the MAT Settings window (see Figure 35), accessible via the menu (Configuration, File Types,
MAT Settings) or from the Export window.

The MAT file contains a global structure array with a field for each node structure. Each node
structure contains four fields. Field columns contains the column names and indices of the
columns, fields combines multiple columns into one field (e.g. ax, ay and ax into accelero-
meter), data contains the sensor data, and samplingRate contains the sampling rate.

The following settings can be modified for the MAT file format:

e Struct Name: The name of the global structure array.

e MAT Version: The MAT-file version (see MatLab documentation).
e MAT Compression: Enable compression of the MAT file.

e No. of Samples: The number of samples in the MAT file. This option is not relevant when
exporting an itlog file to MAT. Only when logging directly to a MAT file, the number of sam-
ples to store needs to be known beforehand. If more (or less) samples are logged, these are
ignored (or filled with NaN).

The sensor data added to the MAT file can be configured by (un)checking the desired Columns.
For nexoDAQ, the data is made available in the logfile by selecting the ADC option. The Ap-
ply button saves the settings and closes the window. The Close button discards any modified
settings and closes the window.

" MAT Settings %
Settings Columns
Struct Name inertia —NIGEE
I SegNr, Slot, Index
MAT Version vi3 V MNode ID

MAT Compression  Enabled LEtSamEss

O Accelerometer
MNo. of Samples

(J Compass
(Ignored by Export)

[ Gyroscope

RSSI

JRTC

[ Orientation (Quaternion)
[ Orientation (Euler Angles)
ADC

[ Status

[ Accelerometer (High G)
[l Pressure

[J Temperature

JIMA

dio

Extra Structs

[ GNSS

Figure 35: MAT Settings
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3.6.3 Visual3D Settings

The Visual3D Settings are not applicable to data acquired with a nexoDAQ device.

3.6.4 ITLOG Settings

Inertia Log Files can be merged or rewritten. The ITLOG Settings can be modified in the ITLOG
Settings window (see Figure 36), accessible via the menu (Configuration, File Types, ITLOG
Settings) or from the Export window.

When multiple itlog files are selected in the export window, these will be merged together into
one file. When one jtlog file is selected, it will be parsed and rewritten.

By default, the source info of the new itlog file will be the same as the (first) source file. The
source info can be changed by enabling the Enable Replacing Source Info checkbox. Use the
Load Info From Source File button to fill the fields with the source info of the (first) source file.

The following fields can be modified:

Created Date: Unix timestamp when the file was created (required).

Version Info: Information about the application that created the file.

Original Filename: The original name of the file, for example when the file was downloaded
from the flash memory of a sensor node.

e Description: Extra information that was provided when creating the file (see Section 3.3).

The Apply button saves the settings and closes the window. The Close button discards any
modified settings and closes the window.

ITLOG Settings b4

Merge or re-write ITLOG file
Global

8 Enable Replacing Source Info

Load Info From Source File

Source Info

Created Date 0
Version Info

Criginal Filename

Description

Apply Close

Figure 36: ITLOG Settings
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3.7

Replaying a Logfile

The Replay Logfile window can be used to replay a previously created logfile in real-time, or
analyze and plot an entire logfile.

3.7.1

Real-Time

Real-time replay has the following options:

Logfile: The logfile to be replayed.

Hardware Type: (CSV only) The hardware type of the device used in the logfile. This is
necessary to determine to correct initial orientation in the tracker.

Rewrite Replay: (CSV only) The logfile will be rewritten to a new file (same name, with
-replay appended), and the orientation (Euler angles and/or quaternions) will be re-
calculated.

Sampling Rate: The sampling rate used in the logfile. Used to calculate the Read Interval.

Number of Nodes: The number of nodes in the logfile. This is used to calculate the Read
Interval.

Read Interval: The number of samples to read per second. The initial value is deter-
mined by the Sampling Rate and Number of Nodes, but the interval can be manually
adjusted. During a replay, the slider can be used the change the speed of the replay.

Replay Logfile X

Logfile

CA\Users\RalucaOneDrive\lnertia\Testing\2024-11-21 nexo testing\nexo_logfile_3axis_ICP_1_BACKUP_.itlog [ Browse

O Real-time O Analysis

auto-detect
Sampling Rate (Hz) | 10000 »
Number of Nodes _"2 v
Read Interval '
oo samples/s
Start

Close

Figure 37: Replay Logfile window

A replay is started with the Start button, and stopped with the Stop button. During the replay,
it can be paused with the Pause button. The buttons in the toolbar can also be used to control
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the replay. Replays are added to the drop-down menu of the Connect button. Finished replays
are removed from the drop-down menu when the Available... option is used.

Figure 38 shows the Inertia Studio main window while replaying a logfile.

Figure 38: Replaying a logfile

Replay analysis can be used to analyze a logfile and detect timestamp issues. It detects Roll-
backs (timestamp is lower than the previous timestamp), for example when the sampling rate
is changed during the experiment. Duplicate Timestamps are detected when subsequent time-
stamp are the same. Gaps are detected when samples are lost.

It has the following options:
o Logfile: The logfile to be analyzed.
* Rollbacks: Detect and show timestamp rollbacks in the log.
e Duplicate Timestamps: Detect and show duplicate timstamps in the log.
e Gaps: Detect and show timestamp gaps in the log.

e Show Sample Data in Plots: Collect all the sample data and show them in the plots once
analysis is finished. For large logfiles, this requires a lot of memory.

Analysis is started with the Start button, and stopped with the Stop button. During the analysis,
it can be paused with the Pause button. Once the analysis is finished the data of the logfile is
shown in the plots. When the plot layout is changed, Reload Plot can be used to recreate the
plots. Clear Results will clear the log and remove the collectd sample data from memory.
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Replay Logfile x

Logfile C\Users\Raluca\OneDrive\lnertia\Testing\2024-11-21 nexo testing\nexo_logfile_3axis_ICP_1_BACKUP_itlog Browse

O Real-time  © Analysis

@ Duplicate Timestamps Gaps

Show in Log:
[J Show Sample Data in Plots (High Memory Usage!)

Reload Plot Clear Results
[ Start l Stop
Start a replay. |
i Close

Figure 39: Replay Logfile

Figure 40 shows the result of the analysis performed on the given logfile. The analysis identifies
the gaps in the acquired data, giving an overview about the number of lost samples, total
number samples, rollbacks, duplicates, gaps, sampling rate and log duration.

Raplay Loghle

o . Bl - B logfile CAUsers\RaiucaOneDrive\nertia\Testing}2024-11-21 newo testingnexo_logfile_Jaxis_ICP_1_BACKUP. itlog

Real-time  © Analysis

detected
rolibadks:
duplicates 0
gaps

Clear Results

Figure 40: Replaying a logfile
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3.8 Configuring the Sensors

The Sensor Settings window can be used to modify the configuration of Inertia nodes. This
window is accessible via the toolbar and via the Configuration menu, item Sensor Settings.
Once a device is connected, the configuration options of the detected Inertia nodes is shown
in this window.

Sensor Settings (com23)

-~ Global
\j'-nexoDAQ

Channel 1
Channel 2
Channel 3
Sensor Excitation
- Status

Sampling Channels

@ NodelD
@ 142 (Gateway)

\' ) Refresh H Lo )

Apply Settings Close

Figure 41: Sensor Settings

Figure 41 shows the Sensor Settings window, which is divided in the following areas:

e The node list area, marked with green in Figure 41, contains the list of devices available
via the currently selected connection. When a node is selected, its configuration options
are shown in the sensor tree. When a node is checked by using the checkbox beside it,
the actions of the buttons refer to this node. In Figure 41, all nodes are checked, so the
configuration is applied to all these nodes after pressing the Apply Settings button.

e The sensor tree, marked with red in Figure 41, shows the available configuration op-
tions of the selected nodes in the node list. When choosing an option in the tree, the
corresponding configuration settings are shown in the settings panel. The different con-
figuration options in the sensor tree are discussed in the subsequent sections.

e The buttons, marked with blue in Figure 41, have the following functions:
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Refresh This button can be used to request all the configurations from all nodes.
The purpose is to make sure that configurations are successfully applied and cor-
rectly retrieved by Inertia Studio.

Store This button stores the current configuration of the checked nodes in their
flash memory, so the settings are retained when the nodes are turned off. The
button is not visible if configurations are automatically stored (paragraph 3.12.2.1).

Restore This button can be used to restore all the configurations of the checked
nodes. The nodes are reset to their factory-default settings.

Apply Settings This button applies all the modified settings (shown bold in the sen-
sor tree) to the checked nodes in the list. If no settings are modified, the currently
shown settings are applied If settings are stored automatically, a 15 second count-
down is shown.

Close This button closes the window, discarding all modified settings.

e The settings panel, marked with in Figure 41, shows the settings available for
the selected configuration option of the selected node in the node list. These settings
are discussed in detail in the subsequent sections. When invalid or not recommended
settings are used, these settings are marked with a red (invalid) or orange (not recom-
mended) colour. Invalid settings cannot be applied. Error, warning and information
messages are shown below the Apply Settings and Close buttons. The settings panel
also contains a Refresh and Restore button at the top-left corner. These buttons can be
used to refresh or restore the selected configuration of the selected node.

3.8.1 Global Settings

By selecting the Global configuration option from the sensor tree, the global settings can be
edited, as shown in Figure 42:

e Transmit Data: Data transmission can be switched off by unchecking the check-box. Nodes
keep sampling (i.e. to store data in the flash memory).

e Sampling Rate (Hz): Selects the sampling rate used by the sensors. Some sensors may be
limited to a lower sampling rate. When using Synchronous sampling mode, the default max-
imum number of nodes supported by the network for a selected sampling rate is shown on
the right. The maximum sampling rate is 10.000 Hz.

* No. of Nodes: The number of nodes in the network to which the device is currently con-
figured. For gateways this can be modified to match the configuration of the node(s). For
nodes this is automatically changed to match the gateway settings. The combination of
Sampling Rate and No. of Nodes determine the number of samples in a radio packet. For
best performance, this should be a round number.
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Sampling Mode: Inertia nodes can be configured to Synchronous or Stand-alone sampling.
When sampling synchronously, the gateway dictates the time when the nodes take a sample.
Nodes do not take samples until a gateway is detected. In stand-alone mode, each node
decides on its own when to take a sample.

Transmit Type: Data can be transmitted using Wireless (Radio), USB or both.

Frequency Channel: Selects the frequency channel used by the Radio. To establish a con-
nection, the channel of the nodes has to be the same as the channel of the gateway. When
changing channel, it is recommended to first change the frequency channel of the nodes,
and then the channel of the gateway.

Disable Radio: Disable to radio, for example to save power. The device will not be accessible
anymore, except via USB.

Sensor Settings (com23) *
- Global Global Settings L s
v nexoDAQ i
Channel 1 Configuration
Channel 2 Transmit Data
-Channel 3 . ———
Sensor Excitation Sampling Rate (Hz) 10000 ~ (2 nodes supported)
Status B —
Sampling Channels MNo. of Nodes 2 ~ (15 samples per packet)
Sampling Mode Synchronous &5
Transmit Type Wireless b
Frequency Channel 24 ~
Disable Radio O
NodelD ™
142 (Gateway)
Refresh H S
Apply Settings Close

Figure 42: Global Settings
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3.8.2 Channel Settings

The nexoDAQ provides connections for three analog inputs, which are used for reading exter-
nal sensors. While Section 2.6 describes the hardware connections for each sensor type, this
section details the corresponding software settings.

From the sensor tree, choose the channel number for which the settings are being made:
Channel 1, Channel 2 or Channel 3.

Some sensors require an external excitation source to produce an electrical output. Use the
Sensor Excitation settings to adjust parameters related to sensor excitation.

The settings related to a particular channel include a Configuration subdivision, with the fol-
lowing options:

Enabled: Enables sampling of the channel.

Transmit Data: If the channel is enabled, data will be transmitted. This is overruled by global
transmission settings (see Section 3.8.1).

Log to Flash: If the channel is enabled, data will be logged to flash. See Section 3.4.1 about
how to start a flash log.

Sampling Rate (Hz): The sampling rate of the channel (maximum 10000 Hz).

Conversion: The conversion factor used to convert a raw measurement to unit.

The settings associated with each sensor type can be set within the Channel Setting subdivi-
sion, as detailed in the following paragraphs.
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3.8.2.1 +10V Differential Signals
For low-voltage +10 V differential signals, select the Low Voltage option from Channel Settings
and choose Differential from the drop-down list Mode, as in Figure 43.

The nexoDAQ optionally provides positive and negative sensor excitation up to 30V. This can
be set by enabling the Sensor Excitation option and pressing on the Configure shortcut (see
also Paragraph 3.8.2.9).

Sensor Settings (com23) x>
-~ Global nexoDAQ Channel 3 Settings [N
v nexoDAQ _
. Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne b Transmit Data [ /]
Sensor Excitation
-~ Status Log to Flash ]
“.Sampling Channels
Sampling Rate (Hz) 10000 ~

Channel Settings
© Low Voltage

Mode
O High Voltage
H Impedance (C0) 10M &
(O IEPE
® NodelD O Charge Coupling DC ~
B 142 (Gateway) ~
® s 0 4-20 mA Gain 1
Sensor Excitation (J Configure
\r Refresh H L)
Apply Settings Close

Figure 43: nexoDAQ settings for low-voltage +10 V differential signals
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3.8.2.2 +10V Single-ended Signals
For low-voltage +10 V single-ended signals, select the Low Voltage option from Channel Set-
tings and choose Single Ended from the drop-down list Mode, as in Figure 44.

The nexoDAQ optionally provides positive and negative sensor excitation up to 30V. This can
be set by enabling the Sensor Excitation option and pressing on the Configure shortcut (see
also Paragraph 3.8.2.9).

Sensor Settings (com23) x>
-~ Global nexoDAQ Channel 3 Settings [N
v nexoDAQ _
. Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne b Transmit Data [ /]
Sensor Excitation
-~ Status Log to Flash ]
“.Sampling Channels
Sampling Rate (Hz) 10000 ~

Channel Settings
© Low Voltage

Mode Single Ended v
O High Voltage
H Impedance (C0) 10M &
(O IEPE
® NodelD O Charge Coupling DC ~
B 142 (Gateway) ~
® s 0 4-20 mA Gain 1
Sensor Excitation (J Configure
\r Refresh H L)
Apply Settings Close

Figure 44: nexoDAQ settings for low-voltage +10 V single-ended signals
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3.8.2.3 Full Bridge
For full-bridge signals, select the Low Voltage option from Channel Settings, choose Differential
from the drop-down list Mode and enable the Sensor Excitation option, as in Figure 45.

The nexoDAQ optionally provides bridge excitation from 5 V up to 30V with a maximum load
current of 25 mA. This can be set by pressing on the Configure shortcut (see also Paragraph
3.8.2.9).

Sensor Settings (com23) X
- Global nexoDAQ Channel 3 Settings [N
v nexoDAQ _
. Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne b Transmit Data [ /]
Sensor Excitation
-~ Status Log to Flash ]
i.. Sampling Channels
Sampling Rate (Hz) 10000 ~

Channel Settings
© Low Voltage

Mode
O High Voltage
H Impedance (C0) 10M &
(U IEPE
® NodelD O Charge Coupling DC ~
@ 142 (Gateway) ~
® s 0 4-20 mA Gain 1
Sensor Excitation @ Configure
\r Refresh H L)
Apply Settings Close

Figure 45: nexoDAQ settings for full bridge signals
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3.8.2.4 +100V Signals
For high-voltage +100 V signals, select the High Voltage option from Channel Settings, as in
Figure 46. The mode is automatically set to Single Ended.

The nexoDAQ optionally provides positive and negative sensor excitation up to 30 V. This can
be set by enabling the Sensor Excitation option and pressing on the Configure shortcut (see
also Paragraph 3.8.2.9).

Sensor Settings (com23) x>
-~ Global nexoDAQ Channel 3 Settings [N
v nexoDAQ _
. Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne b Transmit Data [ /]
Sensor Excitation
-~ Status Log to Flash ]
“.Sampling Channels
Sampling Rate (Hz) 10000 ~

Channel Settings

O Low Voltage

Mode Single Ended
O High Voltage
_ Impedance (1) 10M
(O IEPE
® NodelD™ O Charge Coupling
B 142 (Gateway) ~
@ s (4-20 mA Gain 1
Sensor Excitation (J Configure
\' Refresh H =
Apply Settings Close

Figure 46: nexoDAQ settings for high-voltage +100 V signals
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3.8.2.5 IEPE / ICP© sensors
For IEPE / ICP© sensors, select the IEPE option from Channel Settings, as in Figure 47. The
Sensor Excitation option is automatically enabled.

The IEPE voltage can be modified in the Sensor Excitation settings window by pressing the
Configure shortcut (see Paragraph 3.8.2.9).

Sensor Settings (com23) x>
-~ Global nexoDAQ Channel 1 Settings l\"" Y
v nexoDAQ _
Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne o Transmit Data [ /]
Sensor Excitation
- Status Log to Flash ]

Sampling Channels

Sampling Rate (Hz) 10000 ~

Channel Settings

O Low Voltage

Current (mA) 4 AC
O High Voltage
Gain 10
O IEPE
@ NodelD O Charge
B 142 (Gatewa ~
( Y) O 4-20 mA
8 s
Sensor Excitation Configure
l\("‘ Refresh H L)
Apply Settings Close

Figure 47: nexoDAQ settings for IEPE / ICP© sensors
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3.8.2.6 Differential Charge Signals
For differential charge signals, select the Charge option from Channel Settings and choose
Differential from the drop-down list Mode, as in Figure 48.

Sensor Settings (com23) *
-~ Global nexoDAQ Channel 2 Settings 6’3 =
v nexoDAQ i i
Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne o Transmit Data a
Sensor Excitation
i Status Log to Flash a

i Sampling Channels

Sampling Rate (Hz) 10000 ~

Channel Settings
O Low Voltage

Mode
O High Voltage
Coupling DC
O IEPE
@ NodelD™ O Charge Range (nC) 1 v
B 142 (Gateway)
e s O 4-20 mA Gain L

Sensor Excitation (J Configure

Q,\ Refresh H n

Close

Figure 48: nexoDAQ settings for differential charge signals
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3.8.2.7 Single-ended Charge Signals
For single-ended charge signals, select the Charge option from Channel Settings and choose
Single Ended from the drop-down list Mode, as in Figure 49.

Sensor Settings (com23) *
-~ Global nexoDAQ Channel 2 Settings 6’3 =
v nexoDAQ i i
Channel 1 Configuration
Channel 2 Enabled a Conversion | 1.0 ~
Ch 13
anne o Transmit Data a
Sensor Excitation
i Status Log to Flash a

i Sampling Channels

Sampling Rate (Hz) 10000 ~

Channel Settings
O Low Voltage

Mode Single Ended %
O High Voltage
Coupling DC
O IEPE
@ NodelD™ O Charge Range (nC) 1 v
B 142 (Gateway)
® s O 4-20 mA Gain 1

Sensor Excitation (J Configure

Q,\ Refresh H n

Close

Figure 49: nexoDAQ settings for single-ended charge signals
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3.8.2.8 Current Loop (4-20 mA) Signals
For current loop (4-20 mA) signals, select the 4-20 mA option from Channel Settings, as in

Figure 50.

The nexoDAQ optionally provides current loop sensor excitation up to 15 V. This can be set by
enabling the Sensor Excitation option and pressing on the Configure shortcut (see also Para-

graph 3.8.2.9).

Sensor Settings (com23)

-~ Global

v nexoDAQ

: Channel 1
Channel 2
Channel 3
Sensor Excitation

-~ Status

Sampling Channels

® NodelD™
B 142 (Gateway)
@ s

Q:" ) Refresh

H S

*
nexoDAQ Channel 3 Settings Q.i"‘ Lo )
Configuration
Enabled ] Conversion | 1.0 ~
Transmit Data ]

Log to Flash a
Sampling Rate (Hz) 10000 ~
Channel Settings
Low Volt
s Mode Single Ended
O High Voltage
Impedance (Q0) 200
O IEPE
O Charge Coupling DC
0 4-20 mA Gain
Sensor Excitation (J Configure

Apply Settings

Close

Figure 50: nexoDAQ settings for current loop (4-20 mA) signals
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3.8.2.9 Sensor Excitation

The settings for Sensor Excitation include the adjustment of the built-in IEPE voltage source
in the JIEPE voltage field, and setting the positive and negative sensor Excitation Exc+ and Exc-
(see Figure 51). Exc+ and Exc- are the corresponding pins on the Lemo connector, see Table 1in
Section 2.6. These voltage settings are shared across the three channels, but can be individually
enabled or disabled per channel in the channel settings.

—_

Sensor Settings (com23) x>
- Global Sensor Excitation Settings ) oY
v nexoDAQ i
- Channel 1 Configuration
- Channel 2 IEPE Voltage 24
- Channel 3
- Sensor Excitation
Status Excitation
- Sampling Channels
Exc + 5
Exc - -5
® NodelD”
B 142 (Gateway)
a8 s
Refresh H =
Apply Settings Close
e

Figure 51: nexoDAQ settings for sensor excitation


http://www.inertia-technology.com

3.8.3 Status Settings

By selecting the Status configuration option from the sensor tree, the settings for status sam-
ples can be modified. Status samples consist of the battery level, CPU-temperature and exter-

nal input detection (e.g. whether USB is plugged in). Figure 52 shows the Status Settings, with
the following parameters:

e Enabled: Enables the status samples.

e Interval (s): The interval in seconds at which status samples are transmitted.

S
Sensor Settings (com23) x

- Global Status Settings . L~
\:'-nexoDAQ
Channel 1
Channel 2 Enabled ]
Channel 3
ensor Excitation

‘. Sampling Channels

Configuration

Interval (s) 1 ~

@ NodelD™
B 142 (Gateway)
@ s

Refresh H Lo )

Apply Settings Close

Figure 52: Status Settings
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3.84 Sampling Channels

nexoDAQ uses sampling channels for each enabled sensor. The Sampling Channels information
window (Figure 53) shows a summary of the used sampling channels, as follows:

Channel: The channel number assigned to the sensor.

Sensor: The name of the sensor that uses the channel.

Wordsize (bit): The size in bits of one value.

Ne Values: The number of values in a sample.
e Conversion: The factor to convert a raw measurement to unit.

The Status information is considered to be a separate sampling channel.

R
Sensor Settings (com23) *
Sampling Channels
Channel Sensor Wordsize (bit) N2 Values Conversion
0 nexoDAQ Channel 4 24 3 0.000002563
- Status 5 Status
Sampling Channels
@ NodelD™
@ 142 (Gateway)
a8 s
Refresh H =S
Apply Settings Close
e

Figure 53: Sampling Channels
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3.9 1/0 Functionality

The Advanced Inertia Gateway has two BNC I/O ports, each supporting Trigger Output, Trigger
Input, Sync Output and Sync Input actions. The I/O ports can be configured for each of these
actions in the Configuration -> |/0O Settings menu, as described in more detail below.

3.9.1 Trigger Output

One or both EXT SYNC ports can be configured as Trigger Output in the Configuration -> I/0
Settings menu. Make sure the correct node and port number are selected, then select Trigger
and Output (see Figure 54).

1/0 Configuration x

Node |8 (Gateway) e @3 L—_‘ ﬂ

‘

1/C Configuration

Node |8 (Gateway) e @3 L—_‘ ﬂ

Port1 | Port2
Trigger (Active)

O nput (@ Output

Port1 | Port2
Trigger (Active)

® Input (O Output

Range (V] |0.0-5.0 b [lnvert Pelarity

O Invert Polarity [Js00 Impedance

|:| 500 Impedance Driving Enable Trigger Options:

Enable Trigger Options: Trigger Input Type | Edge ~
Trigger Output Type Level w Action to Perfform ] Reset Frame Counter

Send Timestamp Message

ok o T

Actions on which to trigger Start of Flash Logging
[Istop of Flash Legging

Level Reset Action Stop Flash Logging

[ Reset GPIO
Output Commands: []Show in Teolbar Input Commands: Show in Toolbar
Set High Set Low Toggle (High) Read
Apply Close Apply Close

Figure 54: Trigger Output settings Figure 55: Trigger Input settings
Trigger (Active) means that it is already the current selection. Several voltage ranges are pos-
sible up to a maximum range of =10 V to +10 V. Further options exist for inverting polarity and
50 2 impedance driving. The impedance can be set to very high (> 1 G(2) by deselecting the
50 €2 impedance.

For the trigger signal itself there are some options as well. Enable the trigger options by check-
ing Enable Trigger Options. The trigger type can be either Pulse or Level. It can be activated in
several ways: combined with starting or stopping flash logging, or set manually using the 1/0
buttons in the toolbar (see Figure 56).

The buttons in the toolbar can be enabled via the menu (View -> Toolbar -> Show I/0 Buttons)
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or directly in the I/0 Configuration window by checking the checkbox Show in Toolbar.

Disconnect Record Pause Sensor Settings  Preferences Hide Clear Layout Tracker Zoom|In  Zoom Out Qutput High Qutput Low

Figure 56: Inertia Studio toolbar with 1/0O Buttons

If the signal is successfully set, a message indicating success appears in the notification area.
If the signal is set during logging to file, the event is stored in the log file.

The trigger events are not stored in the flash memory of the nodes. Instead, when starting a
flash log, the output signal can automatically be set to high. When stopping a flash log, the
output signal can be set to low. To achieve this, check the checkbox of the gateway in the
Logging to flash window (see Section 3.4.1) before pressing Start and Stop.

3.9.2 Trigger Input

One or both EXT SYNC ports can be configured as Trigger Input in the Configuration -> /0 Set-
tings menu. Make sure the correct node and port number are selected, then select Trigger and
Input (see Figure 55). Trigger (Active) means that it is already the current selection. Options
are available for inverting polarity and 50 €2 input impedance. The input impedance can be set
to very high (> 1 G(?) by deselecting the 50 €2 impedance. Enable the trigger options by check-
ing Enable Trigger Options. For the trigger input type currently just one option is supported,
namely Edge.

If Enable Trigger Options is active, several actions can be performed when a trigger is received:
Reset Frame Counter resets the frame counter as well as the time stamps to O;

Send Timestamp Message sends a time-stamped message to Inertia Studio, which will then
appear in the notification area and, if data is being logged by Inertia Studio, in the log
file as well.

If the Hold-off time is set to O, the action is performed immediately after the trigger is received.
Otherwise, the action is performed after the delay time that is specified here.

3.9.3 Sync Output

One or both EXT SYNC ports can be configured as Sync Output in the Configuration -> |/O
Settings menu. In this mode, a periodic clock signal can be sent to connected devices for syn-
chronization. Make sure the correct node and port number are selected, then select Sync and
Output (see Figure 57).

Sync (Active) means that it is already the current selection. Several voltage ranges are possible
up to a maximum range of =10 V to +10 V. Further options exist for inverting polarity and 50 €}
impedance driving.
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Finally, the Synch frequency and its Phase shift can be set to a value between 1 and 1500 Hz
for the frequency and at most 1 second for the phase shift.

I/0 Configuration

Node |8 (Gateway) w

Port1 Port2
Sync (Active)

O lnput @) Output

I/0 Configuration

Node |8 (Gateway) w

Port1 | Port2
Sync (Active)

® Input (O Qutput

Range (V) |0.0-3.3 v [lnvert Pelarity

[Jlnvert Polarity [1500 Impedance

500 Impedance Driving Sync Frequency (H2)
Sync Frequency (Hz) Phaze Shift (z)

Phase Shift (<) 0.0025 w

Apply Close Apply Close

Figure 57: Sync Output settings Figure 58: Sync Input settings

3.9.4 Sync Input

Any one EXT SYNC port (but not both together) can be configured as Sync Input in the Con-
figuration -> /0 Settings menu. In this mode, a periodic clock signal can be received from an
external device for synchronization. Make sure the correct node and port number are selected,
then select Sync and Input (see Figure 58). Sync (Active) means that it is already the current
selection. Options are available for inverting polarity and 50 €2 input impedance, similar to the
other synchronization configurations.

Finally, the Synchronization frequency and its Phase shift can be set to a value between 1 and
1500 Hz for the frequency and at most 1 second (or less, depending on the frequency) for the
phase shift. The given frequency and phase shift are used by the synchronization algorithm in
the Gateway to determine what the incoming reference clock signal represents. The timing of
the whole system will then be based on this reference.
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3.10 The Tracker

The Tracker window is not applicable to a nexoDAQ device.

3.11 GNSS Map

The GNSS Map window is not applicable to a nexoDAQ device.

3.12 Appearance and Preferences

The appearance of the plots can be changed via the Preferences and the Layout Configuration
windows. The following sections present the configuration options of both windows in detail.

3.12.1 Layout Configuration

The Layout Configuration window is accessible from the toolbar and via the menu View, item
Layout Wizard. Section 3.12.1 describes how this option can be used to change the type and
number of plots that are shown in the main screen.

The layout wizard makes it easy to quickly switch between layouts, or to make a custom screen
layout. Simply select one of the predefined layouts from the list and press the Finish button.
The relevant layouts for nexoDAQ are:

¢ Analog Inputs + FFTs (3x): Plots for the first three analog inputs, and for their FFTs.
e Empty Screen: No plots are shown.

e Custom Layout: The number of plots, the type of sensor data and the location on the
main screen can be chosen by the user.

Figure 59 shows the layout wizard set for Custom Layout. A custom layout can be created either
by modifying the number of visible rows and columns or by changing the plot type using the
Change button.

In the latter case, the Plot Selection window appears, allowing the selection of a different plot
type. When the Only show available sensors selection box is checked, the window shows only
the available sensor types of the connected nodes. Otherwise, the window shows all the avail-
able plot types.

Processed data can also be shown in the plots. For each ADC input, the FFT (Fast Fourier
Transform) can be applied to raw sensor analog signals (see Section 3.12 for changing the FFT
settings)

The Y-axis label of each plot can be modified, with the constraint that it must be unique. By
pressing the yellow arrow, the label resets to its default value.
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INERTIA

I Layout Configuration
Screen Layout

| nexo

Rows 2 Columns 3

Plot Selection

T T [J Only show available sensors
> -Acceleration (High G)
> -Compass
> -Gyroscope
> -Pressure
> -Temperature
v

Change

&=

Figure 59: Layout Wizard with custom layout and Plot Selection window

~ Finish  Cancel
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3.12.2 Preferences

The Preferences window is accessible from the toolbar and via the menu Configuration, item
Preferences. The four tabs of the Preferences window are described in the following sections.
After any modification of the preferences, press the Apply button to apply them. Press the
Close button to discard all changes.

3.12.2.1 Global

In the Global tab, the following preferences can be edited:

Small Icons in Legend: Shows small or large iconsin the
legend.

Automatically Check for Updates: Checks every week
if a new version of Inertia Studio is available.

Store Sensor Settings Automatically: Automatically
stores the sensor settings permanently on the node(s),
15 seconds after applying.

Automatically Open Export Window: Open the Export
Logfiles window (see Section 3.6 when an Export starts.
Show Network Adapters: Shows the network adapters
that can be used to connect to an Advanced Inertia
Gateway via Ethernet.

Down Sampling: A number of samples can be averaged
before showing them in the plot. This improves perfor-
mance, but shows a flattened signal. Down sampling
cannot be applied to FFT plots and has no effect on the
values in the log files.

Sample Loss Interval (s): Sets the interval in seconds
used for the accumulation of lost samples and calcula-
tion of the sample loss percentage, shown in the leg-
end.

Plot History (s): Sets the maximum number of seconds
of data to show in the plot (visible when panning the
plot).

Appearance: Selects the appearance of the screen -
Light, Dark or System.

Register File Extensions: Registers the itlog and fwu
(firmware update file) file extensions to Inertia Studio.

Preferences

Tracker
Plot

|_J Small lcons in Legend

8 Automatically Check for Updates
Store Sensor Settings Automatically
] Automatically Open Export Window
Show Metwork Adapters

Down Sampling None 5

Sample Loss Interval (s) 1
Plot Histery (s) 120
Appearance Light

Register File Extensions

Apply Close

FFT
Node

Averaging

alv| 4l

Figure 60: Global Prefer-

ences
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3.12.2.2 Plot
In the Plot tab, the following preferences can be edited:

Auto Scaling on Y-axis: Automatically adapts the limits of the Y-axis to the minimum and
maximum value of each plot.

Show Minutes on X-axis: Use minutes for the X-axis timestamp, instead of only seconds.
Show X-axis Grid: Shows grid lines on the X-axis (vertical lines).

Show Y-axis Grid: Shows grid lines on the Y-axis (horizontal lines).

Enable Anti-Aliasing: Enables anti-aliasing to smoothen the plots.

Show Gaps when Samples are Lost: When samples are lost, show a gap in the plot
instead of connecting the points directly.

Multi-Threaded Rendering: Uses multiple threads to render the plots.

Hardware Acceleration: Uses the graphics card of the PC to draw the lines in the plots.
Select which rendering method to use.

Background Colour: Changes the colour theme to a black background with white axes,
or a white background with black axes.

Update Speed: Modifies the speed at which the plots are updated. Setting the slider
closer to Slow increases the performance on a slow or overloaded PC (e.g. when showing
many plots or many nodes).

Preferences *

Crientation Tracker FFT
Global : ; Node

B Auto Scaling on Y-axis

Show Minutes on X-axis

[C) Show X-axis Grid

@ Show Y-axis Grid

[ Enable Anti-Aliasing

Show Gaps when Samples are Lost
Multi-Threaded Rendering

Hardware Acceleration  GDI+ w

Background Colour Dark w

UpdaieSpesc Fast 50ms Slow
Apply Close

Figure 61: Plot Preferences
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3.12.2.3 Node
In the Node tab, the following preferences can be edited:

¢ Node number: Selects a node number for changing its preferences.

¢ Description: A description of the selected node that will be shown in the legend. The
yellow arrow will clear the description.

¢ Line colour: Selects the colour to use in the plots for the selected node. The yellow
arrow will reset the colour to the nodes default colour.

¢ Reset for All Nodes: Resets the colour and description of all nodes to their default values.

Preferences X
Orientation Tracker FFT
Global Plot Nede
Mode Mumber 6 (ProMove-V GNSS) v
Description
Line Colour ]

Reset for All Modes

Apply Close

Figure 62: Node Preferences
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3.12.2.4 Orientation
In the Orientation tab, the following preferences can be edited:

¢ Enable Orientation Calculation: Enables calculating the orientation.
¢ Use Compass: Uses data from the compass for orientation calculation.

¢ Reduce Yaw Drift in Rest: Reduce the yaw-drift when the gyroscope is in rest (all axes at
0). Very small measurements will be ignored.

* Reset Orientation in Rest: Resets the orientation when the node stops rotating.
¢ Initial Yaw Angle (°): Sets the initial yaw angle (irrelevant when compass is enabled).
¢ Algorithm: Select the algorithm to use to calculate the orientation quaternions.

e Parameters: Opens a dialog to modify the parameters of the orientation algorithms.

Preferences >
Global Plot MNode
Orientation Tracker FFT

Enable Orientation Calculation
Use Compass

[C] Reset Orientation in Rest

Initial Yaw Angle () 0

Algorithm Valenti ~

Parameters

Gyroscope Drift
Bias Estimation

Configure

Apply Close

Figure 63: Orientation Preferences
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3.12.2.5 Tracker
In the Tracker tab, the following preferences can be edited:

¢ Show Node Numbers: Shows the node number next to the 3D model.

e Show Angles: Shows the Euler angles (roll, pitch, yaw) in the tracker. In the Tracker
window, only one node should be selected.

¢ Show Wireframe: Shows the 3D model as a wireframe.
e Show Axes: Shows the axes of the ground plane.

¢ Use Custom Model: Chooses a custom 3D model to show instead of the model. The
model should be in Wavefront .obj format!. After loading, the 3D model is centered and
scaled to fit in the tracker.

e Background Colour: Changes or resets the background colour of the tracker.

* Model Size: Increases or decreases the size of the 3D model.

Preferences W
Global Plot Mode
Orientation Tracker EFT

Show Node Numbers

Show Angles
] Show Wireframe
] Show Axes

PromoveV.obj

Model Size |

Apply Close

Figure 64: Tracker Preferences

1The .obj file should start with three-coordinate vertices followed by three-elements faces. The easiest
method to create these files is using MeshLab. First, open or import the model. Then go to the File menu and se-
lect Export Mesh (As).... Select Alias Wavefront Object (*.0bj) as filetype. In the next window, deselect everything
(or select None) and press OK.
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3.12.2.6 FFT
In the FFT tab, the following preferences can be edited:

Window Function: Selects the window function used by the FFT algorithm. The available
options are: Rectangular, Triangular, Hamming, Hanning and Blackman.

X-axis Scale: Selects the scale of the X-axis as a linear or a logarithmic scale (in decibel).
Y-axis Scale: Selects the scale of the Y-axis as a linear or a logarithmic scale (in decibel).
FFT Points (2/): The number of samples used as input for a FFT calculation (2FFT Points),
FFT Interval (s): The time in seconds between subsequent FFT calculations.

Remove DC: Reduce the 0-component by removing the mean DC signal.

FFT Averaging: The number of FFTs to average when plotting.

Preferences *
Global Plot Mode
Orientation Tracker FFT

Window Function

X-axis Scale Linear ~
Y-axis Scale Linear w
FFT Points (2] 12 =
FFT Interval (s) 0.5
Remowve DiC
FFT Averaging 1

Apply Close

Figure 65: FFT Preferences
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3.13 Updating the Firmware

The firmware can be updated for all the Inertia devices (e.g. the Inertia Gateway and nexoDAQ
devices). The firmware is available for download from the Downloads page of the Inertia Tech-
nology website: https://inertia-technology.com/downloads/.

The firmware can be updated either using USB or wirelessly. When updating the firmware
of nexoDAQ, it is recommended to use the USB connection (see Section 3.2 for details about
connecting to USB).

The Firmware Update window can be accessed from the Help menu (Figure 66). Available de-
vices are listed on the left, from current and previously opened connections. The icon indicates
if a device is connected via USB or wirelessly. When available via both, the USB connection is
used. Use the refresh button in the bottom left to clear the connections and devices from the
list and refill it with currently opened connections and available devices.

Information about the selected device, including its hardware type, current firmware version,
and optional build options is shown in the Information box. When a firmware update file
(*.fwu) is selected, its targeted hardware type and firmware version is shown as well.

Use the Details button to show more information about the device and firmware file, such as
hardware revision and a list of firmware components.

i Firmware Update X .
v com10 Node 8
-4 a 8 ChInertia\nexodag_v0.9.0_master.fwu Browse ......
comi12 .
Information

Device nexoDAQ (0020)

0.8.0 branch=master

File nexoDAQ (0020)
0.9.0

Details ~

Progress

Validating... OK

Uploading..

Reprogramming...

Options
@ Reset to Factory Defaults

@ Validate Firmware ID Hardware ID Hardware Rev.

Reprogram Close

Figure 66: Firmware Update

If no firmware is selected, the device can be reset to its factory defaults by checking Reset to
Factory Defaults and pressing Reset. After resetting, the device has to be manually restarted
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for the changes to take effect.

The Progress box shows information about validating, uploading and reprogramming. When
a node is connected and a file selected, Validating... shows whether the file is valid and if
the supported hardware matches the connected hardware. If valid, the Reprogram button
becomes enabled. Once the button is pressed, Uploading... shows the progress of uploading
the firmware to the device. If the upload is successful, the device disconnects and updates the
firmware while a Reprogramming... countdown timer is shown. When finished, the device
reboots and reconnects, and the new firmware information appears in the Information box.
Only one device per connection can be updated at once, while others will be queued.

Do not disconnect or turn off the device during reprogramming!

Reset to Factory Defaults clears the current settings and loads the default settings of the new
firmware once reprogramming is finished. This reset can also be forced by the firmware update
file. In this case, the checkbox cannot be modified. Firmware validation can be disabled to
allow programming an unsupported firmware. This could disable the device and should only
be done when instructed to do so.

If the firmware update resets the sensor settings, the wireless channel is also reset to the
factory settings. After a successful update, if the gateway and the sensor node are on different
wireless channels, the sensor node becomes unreachable. For changing the wireless channel
of an Inertia device, see Section 3.8.1.

Firmware update does not work if the device does not have internal flash memory, if the inter-
nal flash memory is full or (for older firmware) when the maximum number of files is reached.
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4 Performing an Experiment

This section describes how to perform an experiment and how to read and align the data ob-
tained from the experiment.

4.1 Basic steps for making an experiment with nexoDAQ

In the following, we explain how to make a measurement with a nexoDAQ device and a 3-axial
IEPE/ICP© accelerometer sensor.

1. Connectthe antenna to the gateway by using the screw-type coupling mechanism. Connect
the gateway to the PC using the mini-USB cable. The power light of the gateway turns blue
(Figure 67).

Figure 67: Gateway connected to PC

inertia-technology.com Page 73 of 83
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2. Start Inertia Studio. Using the layout wizard, select the predefined layout Analog Inputs +
FFTs (3x) from the list (Section 3.12.1), see Figure 68.

Figure 68: Inertia Studio layout for nexoDAQ,
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3. Connect the gateway in Inertia Studio (Figure 69) by pressing on the arrow next to the first
Connect pictogram button in the toolbar, which opens the drop-down menu with a list with

the names of the available Inertia devices. Select the Inertia Gateway device and press on
the Connect pictogram (for details, see Section 3.2.1).

Z Inertia Studio (x64) 3.7.2
File Configuration View Help

YOI IR N CCUHEE

Connect...
Awvailable...

Inertia Gateway Advanced 143 [com12]
JBL VIBE BUDS (Bluetooth) [jbl vibe buds]
Ethernet

ProMove V BLE Node 2 (Bluetooth LE) [54:64:DE:A3:4D:1D]

Figure 69: Connect the gateway in Inertia Studio
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4. Power-up the nexoDAQ device.

Figure 70: Power up nexoDAQ
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5. Signals are coming in Inertia Studio, but no sensor is connected yet.

£ Inertia Studio (664) 3.7.2 - 0
Ede Comfiguation iew Heip

3, Wl - e

Figure 71: nexoDAQ signals from unconnected inputs

6. Configure the channels in Sensor Settings to ICP© (for details, see Section 2.6.5).

. @ . B, > . . 5, €

nexoDAQ Channel 1 Settings
Configuration
Enabled a
Transmit Data [ ]
Log to Flash [ ]
Sampling Rate (Hz] 10000
Channel Settings

Low Voltage

High Voltage
10

Charge

4-20 ma

Sensor Excitation

Figure 72: Configure ICP© channels in Inertia Studio
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7. Connect the red nexoDAQ cables with the BNC end to the ICP© 3-axial sensor.

Figure 73: Connect the BNC connector of the red cable with the sensor BNC connector

8. Connect the red cables with the Lemo circular connector to the nexoDAQ channel inputs,
by pushing the connector to the input of nexoDAQ with red dot of the connector up.

Figure 74: Connect the sensor to nexoDAQ
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9. Signals from the ICP© 3-axial sensor the are coming in Inertia Studio.

Figure 75: Signals from ICP© 3-axial sensor in Inertia Studio

10. You can now make a logfile (for details see Section 3.3).

$-® 0|8 X/ B-9QQ

Figure 76: Make a logfile with Inertia Studio
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4.2 Reading and Aligning CSV Log Files

Each line in the log file consists of a timestamp and sensor data sampled at that timestamp. A
timestamp is the time in decimal seconds since the gateway was started. Figure 77 shows an
example log file containing timestamps and sensor data from an experiment.

timestamp node-id lostSamples  ax ay az rssi
183.48 23 o 0.244209 -0.174777 10.1993 -52
183.485 23 0 0.258574 -0.181959 10,1921 -52
133.49 23 o 0.237026 -0.179565 10.1873 -52
183.495 23 o 0.253785 -0.169988 10.2017 -52
183.5 23 0 0.241814 -0.189142 10.1825 -52

Figure 77: Example of a log file

Itis important to align the data from multiple nodes based on the timestamps. In a plot show-
ing sensor data from multiple nodes, the timestamps should always represent the x axis. Fig-
ure 78 shows an example of acceleration data from multiple nodes aligned based on time-
stamps.

Please note that logs from multiple nodes can have different number of samples because the
nodes could have started and stopped at slightly different times, they could have different
sampling rates, there are lost samples, etc. This is not important, as long as the sensor data is
aligned based on the timestamps.
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Aligned acceleration data from multiple nodes
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Figure 78: Example of aligned data from multiple nodes based on timestamps
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5 Troubleshooting

5.1 Retrieving an Unreachable Device

If during network reconfiguration the communication with one device is lost and reconnec-
tion is not possible using the procedures described earlier in this manual, please refer to the
following steps for device recovery:

1. Connect the device directly to the computer with a USB cable.

2. Click the Capture item from the File menu and select the serial port associated with the
device from the drop-down list. Press the Start button.

3. Open the Configuration window from the Options menu and select Global in the sensor
tree (see Section 3.8.1). Check the channel number. Change the channel if this doesn’t
match the configuration of the gateway. Transmit Data must be enabled for this device.
A mismatch of the sampling rate can also result in sensor data missing in Inertia Studio.
Note that unless the transmit type is set to USB, the data cannot be captured and shown
directly from a wired device.

5.2 Slow Signals in Inertia Studio

When using multiple nodes, it is possible that the signals in Inertia Studio are displayed slower,
and the software may start to lag. This is likely to be caused by drawing the plots, which is quite
CPU-intensive. The following options are available to increase the performance.

5.2.1 Lowering the Plot Update Speed
The Update Speed of the signals in Inertia Studio can be lowered and the averaging for the
Down Sampling can be increased, as described in paragraph 3.12.2.1 and paragraph 3.12.2.2.

5.2.2 Reducing the Number of Plots or Nodes

The layout wizard can be used the decrease the number of shown plots (see Section 3.12.1).
Decreasing the number of plots lowers the load on the CPU. Reducing the number of nodes
that are plotted at once (see Figure 3.1.1) can also improve performance.

5.2.3 Enabling Hardware Acceleration and Multi-threaded Rendering

Enabling hardware acceleration (see paragraph 3.12.2.2) will, in general, improve the perfor-
mance by delegating some of the calculations to the GPU. Using multiple threads to render the
plots reduces the load of the main thread and improves responsiveness of the user interface.
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5.3

Manually Installing the Inertia Driver

If you are unable to install the Inertia Driver via the provided installer, the driver can be installed
manually. The following steps describe this procedure for Windows.

1.
2.

Connect the Inertia device to the PC. Windows tries to find the correct driver, but fails.

Open the Device Manager from the Start Menu or Control Panel. Go to the Universal
Serial Bus controllers section (ignore the faulty devices in Other devices and Ports (COM
& LPT)).

. Select and double click USB Composite Device. Verify it is the correct one. Go to the

Details tab and select the Hardware IDs property. The value should contain
USB\VID_16D0&PID_090E.

Go to the Driver tab and select Update Driver.

. Select '‘Browse my computer for drivers’, then select 'Let me pick from a list of available

drivers on my computer’.

. Alist with compatible hardware is shown. If it contains the latest Inertia Driver, select it.

Otherwise, select Have Disk... and browse to the location containing inertia.inf. Select
OK and Next.

. The driver is now installed. The USB Composite Device and the faulty devices in Other

devices and Ports (COM & LPT) should disapear, and an Inertia Device will appear in the
Ports (COM & LPT) section.
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